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Introduction

POIConverter will convert Points of Interest (waypoints) stored in the following formats to any of the other 
formats in the list. In addition route and track data conversions are available for the TomTom, Maptech, 
Garmin, GPS eXchange, Excel and OziExplorer formats. A command line mode is also supported.

 TomTom Itinerary files (*.itn)
 Maptech Marks files (*.mxf), Route files (*.rxf), Track files (*.txf)
 TomTom overlays (*.ov2, *.ovr)
 TomTom ASCII files (*.asc)
 Memory-Map CSV Waypoints (*.csv)
 Garmin Database files: Waypoints (*.gdb)
 Garmin PCX5 Waypoint files (*.wpt), Route files (*.rte), Track files (*.trk)
 GPS eXchange files (*.gpx)
 Microsoft AutoRoute Pushpins (*.csv)
 Microsoft Excel files (*.xls)
 OziExplorer Waypoint files (*.wpt), Route files (*.rte), Track files (*.plt)
 Google Earth Points files (*.kml)
 Elektrobit EBA Points files (*.csv)

Also the following formats can be read
 NMEA log files (*.pgl, *.txt, *.log, *.gps)
 MapSource waypoint, route and track data (*.txt) using decimal Lat/Long coordinates
 Microsoft Map files (*.axe, *.est, *.ptm) PushPin and route data
 Pocket Streets PushPin files (*.psp)

and the following formats can be written
 AutoRoute PushPins with Continental numbers (*.tab)
 Destinator 3 waypoint files (*.csv)
 Mapopolis waypoint files (*.mlp)
 Google Earth route and track files (*.kml)

The waypoint symbols are mapped to the set of 16 used by MapSource.

The external data entries are read into an internal data structure that is used to populate the records of the 
selected output format.
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Interactive Mode

Firstly, use the Open button to select an input file of the required type.

Secondly use the buttons (or Options menu) to configure the conversion.

Use the buttons to set default parameters for the Garmin,Maptech, OziExplorer, TomTom, 
GPS eXchange and Elektrobit EBA conversions. 

Use the Lat/Long or OSGB buttons, , to select the coordinate output format for TomTom ASCII files or 
Excel spreadsheets. 

Use the Point, Route and Track buttons to specify the type of data being read or output. These 
buttons can be used to change the type of data to be output. For example, a sequence of points can be 
changed to a route by reading the data in as Points, then prior to output, selecting the Route button and saving 
to a file. 

Use the Append button to read POI data from another file if you wish to join multiple sets. 

Finally, use the Save button to specify the format and name of the output file.

Debugging output will be written to the file debug.txt in the folder that contains the file POIConverter.exe if a 
file named Debug.yes exists in that folder. The file Debug.no can be renamed or a new file created.
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Buttons

The Lat/Long and OSGB buttons, , are used to select the format for the coordinates when data are 
saved to a TomTom ASCII file or Excel spreadsheet.

The Point, Route and Track buttons, , are used to specify the type of data being read into the 
program memory or output to file. The data type can be changed after a file has been read. This could be used 
to convert, say, a list of waypoints (POI) to a route.

The Track filter item in the Options menu can be used to reduce the number of points transferred from a track 
file into the program internal memory.

Command Line Mode

Double-click on the batch file (*.bat) in Windows Explorer or drag the file to the program shortcut to process 
the commands defined in it. When running in debug mode using drag-and-drop will produce a text file, 
debug.txt, in the program installation folder containing output for all the commands in the batch file. When run 
in batch mode the debug.txt file will contain output for just the last command in the batch file. NB Only those 
records containing the arguments -f and -t are processed in drag-and-drop mode, all other records are 
ignored. The ignored records are marked * Ingored * in the debug output file. 

The format of a line in a batch file is
pathpoiconverter -f fcode -t tcode -i infile -o outfile -idt itype -odt otype -cfg cfgfile 
where
path the path to the program executable, ie C:\Richard_Davies\ if the program was installed at the 

default location.
fcode file input type code
tcode file output type code
infile the name of the input file, eg ttfile.asc, "tt file.asc"
outfile the name of the output file, eg "google earth.kml"
itype the type of data in the input file, one of points, routes and tracks
otype the type of data to be written to the output file, one of points, routes and tracks
cfgfile the name of the configuration file. The path to the configuration file can be set using the options 

available for EBA files in the Windows Graphical User Interface (GUI).

The supported code values for points data type are

Description fcode tcode
TomTom text asc asc

TomTom overlay ov2, ovr ov2, ovr
Maptech marks mxf, maptech mxf

Memory-Map csv m-m m-m
Garmin database type 2 gdb gdb

Mapsource txt, mapsource -
GPS eXchange gpx, gpsexchange gpx, gpsexchange

Microsoft map axe, est, ptm, msmap -
AutoRoute csv s&t, ar, csv s&t, ar, csv, tab

Excel table xls, excel xls, excel
Pocket Streets psp -

OziExplorer ozi ozi
Garmin PCX5 pcx5 pcx5

Google Earth kml kml, google kml, google
Elektrobit EBA eba eba

Mapopolis - mlp, mapopolis
Destinator 3 - d3, destinator3
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The supported code values for routes data type are

Description fcode tcode
TomTom itinerary itn, tomtom itn, tomtom

Maptech rxf, maptech rxf, maptech
Garmin PCX5 pcx5 pcx5
MapSource txt txt, mapsource -

GPS eXchange gpx, gpsexchange gpx, gpsexchange
Microsoft map axe, est, ptm, msmap -

Excel table xls, excel xls, excel
OziExplorer ozi ozi

Google Earth kml - kml, google

The supported code values for tracks data type are

Description fcode tcode
NMEA nmea -

Maptech txf, maptech txf, maptech
Garmin PCX5 trk, pcx5 trk, pcx5

GPS eXchange gpx, gpsexchange gpx, gpsexchange
MapSource txt, mapsource txt, mapsource
Excel table xls, excel xls, excel

OziExplorer ozi ozi
Google Earth kml - kml, google

Symbols

POIConverter when changing formats uses the mapping shown in the following table. Any other symbols will 
be mapped to a Waypoint (symbol number 0). NB. Symbol numbers cannot be passed to AutoRoute by any of 
the POIConverter file formats. The Memory-Map and OziExplorer symbol numbering is the same as that for 
MapSource. 

Map 
Source 
Number

Description AutoRoute 
Number Symbol Maptech 

Number Description

0 Waypoint 16 37 Dot
1 Residence 77 118 House
2 Gas Station 142 145 Fuel
3 Car 82 112 Car
4 Fishing Area 108 130 Fish
5 Boat Ramp 154 121 Boat
6 Marina 186 37
7 Shipwreck 56 37
8 Exit 129 37
9 Skull and Crossbones 176 22 Skull
10 Flag 63 23 Flag
11 Campground 153 111 Camp
12 Circle with X 113 37
13 Hunting Area 157 129 Deer
14 Medical Facility 119 138 First Aid
15 TracBack Point 162 37
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Latitude and Longitude Values

When entering latitude and longitude values in TomTom ASC files and AutoRoute CSV files the values may 
be specified either as degrees and fractions of degrees, or in degrees, minutes and seconds. Both colons and 
single-quote/double-quote notation may be used for minutes and seconds. So, all the following values are 
accepted.

53.5
53.5000
53'30"00
53'30
53:30:0

In output files the latitude and longitude values are written as decimal degrees.

OSGB references

When entering OSGB36 references in TomTom ASC files, AutoRoute CSV files and Excel spreadsheets the 
value should be specified using the GB Ordnance Survey National Grid reference convention. The OS 
reference consists of a two-letter prefix followed by eastings and northings expressed as integers. The case of 
the prefix letters may be mixed. The total number of digits in eastings and northings combined must be even, 
with the same number of digits in the easting and northing. So, all of the following values are accepted.

SU 84 46
SU 840 460
SU 84000 46000
su840460
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Destinator 3 Files - Points

The Comma Separated Value (CSV) records output for Destinator 3 have the following format

Name,POIConverter vx.xx,Longitude,Latitude

where POIConverter vx.xx is a text string and x.xx is the current version of the POIConverter program. The 
Destinator 3 documentation will give the procedure to be followed to import CSV data.

The mapping of the data fields is as follows
Internal - Destinator 3 waypoints
Latitude - Latitude

Longitude - Longitude
Date -
Time -

Altitude -
Name -

Description - Name
Comment -
Proximity -

Symbol -
Symbol text -

Route/Track name -
Colour -
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Elektrobit EBA

Elektrobit EBA File Options

The EBA menu option and button, , can be used to set defaults for the Elektrobit EBA and CSV2PSF output 
files. The ISO ALPHA3 country code list box can be used to enter or select a code to be used as the default 
for the EBA file CountryCode field. The three character code will be used in any record that has a blank 
CountryCode field. A few codes are accessible in the drop-down list and the full list of codes is available in 
Wikipedia http://en.wikipedia.org/wiki/ISO_3166-1_alpha-3

The Type ID list box can be used to enter or select a code to be used as the default for the EBA file Type field. 
The conversion programs PSFCreator and CSV2PSF require this to be a four digit integer but a four character 
string can be used to plant a marker in the file can subsequently be changed to a valid code using a text 
editor. A few codes and the marker, ID!?, are available in the drop-down list.

The Sort records on Type field check box can be used to request that the records in an EBA file be sorted into 
ascending order using the EBA Type field as the key. When output to a Google Earth Points file, records with 
the same Type code will be placed in the same folder. The Type code is used for the folder name.

http://en.wikipedia.org/wiki/ISO_3166-1_alpha-3
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The controls in the Configuration file group can be used to define the configuration file name and path and 
whether or not the file should be used. The current path is used as the default path for the -cfg argument when 
using batch mode.

The radio buttons in the Output option group can be used to select the output format of the Elektrobit CSV file. 
Fields additional to those defined in the Elektrobit standard are suppressed when files are created for use with 
the programs CSV2PSF and PSFCreator.

The radio buttons and check box in the Address style group are used to select an address style. This style will 
be used to create an address, from the EBA fields PostalCode etc, for use in Google Earth KML files when 
these are output. The address will be used to populate the KML <description> element for any points where 
the POIConverter comment field is empty.

EBA Configuration File

The EBA configuration file is used to map the EBA Type fields to text descriptions and to define names 
to be used for folders when Google Earth KML Points files are output.

The format of the configuration file is a header record followed by a record for each of the Type IDs used in the 
Elekrobit EMA file (*.csv), eg

ID,folder,folderDesc,icon
9000,"Food & Drink",9000,http://maps.google.com/mapfiles/kml/shapes/snack_bar.png
9002,"Friends & Family",9002,http://maps.google.com/mapfiles/kml/shapes/info-i.png
9003,"Parking for walks",,http://maps.google.com/mapfiles/kml/shapes/hiker.png

The icon field contains the URL that is to be used to show the icon in Google Earth. The URLs can be found in 
the following way

1. Open Google Earth.
2. Click Add, Placemark ... and click on the Placemark icon to the right of the Name text box to 

display the available icons.
3. Click on an icon to reveal its URL and cut-and-paste it into the icon field of the EBA configuration 

file.
Repeat step 3 for any other icons that you want to use.

The Fortran 90 types and sizes of the fields are given in the table below

Field - Field Type and Size (bytes)
ID - CHARACTER(LEN=5)

folder - CHARACTER(LEN=128)
folderDesc - CHARACTER(LEN=128)

icon - CHARACTER(LEN=128)
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Elektrobit EBA Points Files

Point data can be read from and written to Elektrobit EBA files (*.csv). The button EBA file options can be 
used to select one of the three supported output file formats, ie Extended EBA, CSV2PSF and PSFCreator. 
The EBA file options button is used to select the output file format.

The mapping of the data fields is as follows
Internal - Elektrobit Point data
Latitude - Latitude

Longitude - Longitude
Date - file_date
Time - file_time

Altitude -
Name -

Description - Name
Comment - Address details *
Proximity -

Symbol -
Symbol description - "Waypoint"
Route/Track name - "Point data"

Colour -

The standard Elektrobit EBA file has the following format and a header record is optional

CountryCode;Type;Name;PostalCode;City;Street;HouseNumber;Longitude;Latitude;Telephone;NationalImport
ance;SourceID;ExtentionContentType;ExtentionContent

The internal structure of POIConverter has been extended to cover all of these fields. An Options dialog box 
can be used to set values for the CountryCode and Type fields when outputting an EBA file using data input 
from another format.

Additional fields can be used in an Extended EBA (XEBA) format. The names of the additional fields are 
defined in the file header. Up to 10 additional fields can be defined. The field names are limited to 24 
characters and the corresponding data fields are limited to 128 characters. For example

CountryCode;Type;Name;PostalCode;City;Street;HouseNumber;Longitude;Latitude;Telephone;NationalImport
ance;SourceID;ExtentionContentType;ExtentionContent,description,dateVisited

The description field in special; it matches the Google Earth KML element <description> name and any data 
defined for this field will be visible in Google Earth. If the description is modified in Google Earth and saved to 
a KML file then the changed information will be output to any Extended EBA file created from the updated 
KML file.
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CSV2PSF Points Files

Point data can be read from and written to a reduced form of the Elektrobit EBA format used by the program 
CSV2PSF (*.csv). The output file can be used as input to the CSV2PSF program to produce PSFoverlays for 
the Medion GoPal 2.x and Falk FN5 satnav systems. . The EBA file options button is used to select the output 
file format.

The mapping of the data fields is as follows
Internal - CSV2PSF Point data
Latitude - Latitude

Longitude - Longitude
Date - file_date
Time - file_time

Altitude -
Name -

Description - Name
Comment - Country specific details *
Proximity -

Symbol -
Symbol description - "Waypoint"
Route/Track name - "Point data"

Colour -

TheCSV2PSF file has the following format and a header record is optional

CountryCode;Type;Name;PostalCode;City;Street;HouseNumber;Longitude;Latitude;Telephone;NationalImport
ance;SourceID

The internal structure of POIConverter has been extended to cover all of these fields. An Options dialog box 
can be used to set values for the CountryCode and Type fields when outputting an EBA file using data input 
from another format.
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PSFCreator Points Files

Point data can be read from and written to Elektrobit EBA formatted files used by the program PSFCreator 
(*.csv). The output file can be used as input to the PSFCreator program to produce PSFoverlays for the 
Medion GoPal 3.x, Falk FN6 and Blaupunkt Lucca 5.3 satnav systems. The EBA file options button is used to 
select the output file format.

The mapping of the data fields is as follows
Internal - Elektrobit Point data
Latitude - Latitude

Longitude - Longitude
Date - file_date
Time - file_time

Altitude -
Name -

Description - Name
Comment - Address details *
Proximity -

Symbol -
Symbol description - "Waypoint"
Route/Track name - "Point data"

Colour -

The Elektrobit EBA file has the following format and a header record is optional

CountryCode;Type;Name;PostalCode;City;Street;HouseNumber;Longitude;Latitude;Telephone;NationalImport
ance;SourceID;ExtentionContentType;ExtentionContent

The internal structure of POIConverter has been extended to cover all of these fields. An Options dialog box 
can be used to set values for the CountryCode and Type fields when outputting an EBA file using data input 
from another format.
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Garmin

Garmin Output Options

The Garmin menu option and button, , can be used to define defaults for waypoint identifier, altitude, 
proximity and symbol number. The Date and Time fields will be set to those values current when the option 
dialog box is opened. The Date and Time fields will be left blank for tracks that have been converted from 
formats that do not support these entries. Ticking the Replace existing waypoint IDNT box will force new 
waypoint names to be output. These names will be created using the IDNT prefix followed by a unique 
number.
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Garmin Waypoint Files

Garmin PCX5 formatted Waypoint files can be imported into MapSource but not exported from it. Waypoint 
data can be exported as a Tab delimited text file (.txt), which can be read by this program for conversion to 
other formats. MapSource v 6.5 supports the import and export of files in GPS eXchange format, but it does 
not support the proximity field. 

To import the PCX5 waypoint data into MapSource select the Import... item in the MapSource File menu and 
select the waypoint file (*.wpt) to be used. A dialog box giving three options relating to symbol selection will 
appear - select the second of these (16 symbols) and click the OK button. The imported data will always be 
sent to a new map so if any user data already exists in the open map then you will be prompted to save it.

The mapping of the data fields is as follows
Internal - Garmin PCX5 Waypoints
Latitude - Latitude*

Longitude - Longitude*
Date - Date
Time - Time

Altitude - Alt
Name - Idnt

Description - Description
Comment -
Proximity - Proximity

Symbol - Symbol number (0 - 15)
Symbol text - Waypoint, Residence etc

Route/Track name - "Point data"
Colour -

* Degree minute or Decimal degree input as defined in Header (H) record. Output in decimal degrees.

The waypoint names sent to the output file are made unique by adding a sequence number in the final 
character positions of the 6-character identifier. The Options menu item Garmin, or the button , can be used 
to select default values for the Waypoint IDNT prefix, Symbol, Altitude and Proximity. The Waypoint IDNT 
prefix value and a sequence number will be used to generate a waypoint IDNT for the output records if the 
Replace existing waypoint IDNT box is ticked.
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Garmin Route Files

Garmin PCX5 formatted Route files can be imported into MapSource but not exported from it. MapSource v 
6.5 and later support the import and export of files in GPS eXchange format. 

To import the PCX5 route data into MapSource select the Import... item in the MapSource File menu and 
select the waypoint file (*.rte) to be used. A dialog box giving three options relating to symbol selection will 
appear - select the second of these (16 symbols) and click the OK button. The imported data will always be 
sent to a new map so if any user data already exists in the open map then you will be prompted to save it.

The mapping of the data fields is as follows
Internal - Garmin PCX5 Routes
Latitude - Latitude*

Longitude - Longitude*
Date - Date
Time - Time

Altitude - Altitude
Name - Idnt

Description - Description
Comment -
Proximity - Proximity

Symbol - Symbol (0 - 15)
Symbol description - Waypoint, Residence etc
Route/Track name - Route name

Colour -
* Degree minute or decimal degree input as defined in Header (H) record. Output is in decimal degrees.

Garmin Track Files

Garmin PCX5 formatted Track files can be imported into MapSource but not exported from it. The Track filter 
Option can be used to reduce the number of points read from the file. MapSource v 6.5 supports the import 
and export of files in GPS eXchange format. 

To import the PCX5 track data into MapSource select the Import... item in the MapSource File menu and 
select the waypoint file (*.trk) to be used. A dialog box giving three options relating to symbol selection will 
appear - select the second of these (16 symbols) and click the OK button. The imported data will always be 
sent to a new map so if any user data already exists in the open map then you will be prompted to save it.

The mapping of the data fields is as follows
Internal - Garmin PCX5 Tracks
Latitude - Latitude*

Longitude - Longitude*
Date - Date
Time - Time

Altitude - Altitude
Name -

Description -
Comment -
Proximity -

Symbol -
Symbol description - "Dot"
Route/Track name - "Track"nn

Colour -
* Degree minute or decimal degree input as defined in Header (H) record. Output is in decimal degrees.
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Garmin Database Files - Waypoints

Waypoint data can be read from and written to Garmin GPS Database files (*.gdb). The Garmin MapSource 
program can be used to show the waypoint locations on a map.

The mapping of the data fields is as follows
Internal - Garmin GDB waypoint data
Latitude - Latitude

Longitude - Longitude
Date - Date*
Time - Time*

Altitude - Altitude
Name - Name

Description - Comment
Comment -
Proximity - Proximity

Symbol - Symbol number (0 - 15)
Symbol text - Waypoint, Residence etc

Route/Track name - "Point data"
Colour -

* The input file date and time are used if the timestamp is undefined.
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Google Earth

Google Earth Points Files

Waypoint data can be read from and written to Google Earth files (*.kml).

The mapping of the data fields is as follows
Internal - Google Earth Point data
Latitude - <Point><coordinates>

Longitude - <Point><coordinates>
Date - <timePosition>*
Time - <timePosition>*

Altitude -
Name -

Description - <Placemark><name>
Comment - <Placemark><description>
Proximity -

Symbol -
Symbol description - "Waypoint"
Route/Track name - "Point data"

Colour -

* Read from a kml file but not used when writing.

The output file name is used for the Document <name>. 

Google Earth Route Files

Route data can be written to a Google Earth file (*.kml).

The mapping of the data fields is as follows
Internal - Google Earth Routes
Latitude - <LineString><coordinates>

Longitude - <LineString><coordinates>
Date -
Time -

Altitude - <LineString><coordinates>
Name -

Description -
Comment - Snippet <description>
Proximity -

Symbol -
Symbol description -
Route/Track name - Folder and Placemark <name>

Colour -

The output file name is used for the Document <name>. Route/Track name, the length of the route and the 
first point Comment text are output to a Placemark Snippet positioned at the first point of the route.
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Google Earth Track Files

Track data can be written to a Google Earth file (*.kml).

The mapping of the data fields is as follows
Internal - Google Earth Tracks
Latitude - <LineString><coordinates>

Longitude - <LineString><coordinates>
Date -
Time -

Altitude - <LineString><coordinates>
Name -

Description -
Comment -
Proximity -

Symbol -
Symbol description -
Route/Track name - Folder and Placemark <name> and <Snippet>

Colour -

The output file name is used for the Document <name>. The following information is written to the 
<description><table> of a Snippet that is attached to the first point of the track: Name, Length, Started, 
Finished, Maximum altitude, Minimum altitude, Average speed, Maximum speed.
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GPS eXchange

GPS eXchange Output Options

The GPS eXchange menu option and button, , can be used to change the style of the waypoint name 
written to the output file. Ticking the Use uppercase letters only box will convert any letter in the name to 
uppercase but will skip any other characters, including spaces. Ticking the Make names unique box will make 
the waypoint name unique by overwriting the trailing characters of the name with a number denoting the 
multiplicity of the name. The maximum number of characters in the name will be determined by the setting of 
the radio buttons Maximum of 10 characters and Unlimited (maximum of 128). 

GPS eXchange Files – Points, Routes and Tracks

GPX (the GPS eXchange Format) is a light-weight XML data format for the interchange of GPS data 
(waypoints, routes, and tracks) between applications and web services on the Internet. Waypoint, route and 
track data from GPS eXchange files (*.gpx) can be read and written by POIConverter. The Track filter Option 
can be used to reduce the number of points transferred from a file.

The mapping of the data fields is as follows
Internal - GPS eXchange
Latitude - <lat>*

Longitude - <lon>*
Date - <time>*
Time - <time>*

Altitude - <ele>*
Name - <name>*

Description - <desc>*
Comment - <cmt>*
Proximity -

Symbol -
Symbol text - <sym>*

Route/Track name - "Point data"#, <name>+
Colour -

* from <wpt>, <rtept> or <trkpt>
+ from <rte> or <trk> # for <wpt>

The Options menu item GPS eXchange, or the button , can be used to change the style of the waypoint 
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name written to the output file.

The GPX tag <type> is used to define a Memory-Map category for the POI (Marks) when creating a GPX file. 
The output file name is used as the Marks Category name.
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Mapopolis Maplet Files - Points

The Mapopolis utility program GPXToMaplet is run from within POIConverter to convert the GPX data written 
to an intermediate file, having the same name as the *.mlp file but with an extension gpx, to create the maplet 
file (*.mlp).

The mapping of the internal data fields to the intermediate GPX file is as follows
Internal - Mapopolis GPX waypoint data
Latitude - Lat=

Longitude - Lon=
Date - <time>*
Time - <time>*

Altitude - <ele>
Name - <name>

Description - <desc>
Comment - <cmt>
Proximity -

Symbol -
Symbol text - <sym> default "Waypoint"

Route/Track name -
Colour -

* a single item formatted as yyyy-mm-ddThh:mm:ssZ, eg 2004-01-05T19:16:10Z

If POIConverter is run in Debug mode then the intermediate GPX file is left in the same folder as the output 
file. GPXToMaplet can then be run separately to identify any data problems.

MapSource Files – Points, Routes and Tracks

Waypoints, routes and tracks can be exported from MapSource as Tab delimited text files (.txt) and read by 
this program for conversion to other formats. GPS eXchange, Garmin database and Garmin PCX5 formatted 
data can be imported into MapSource. NB Garmin ceased to support the PCX5 format in MapSource version 
6.5. The Track filter Option can be used to reduce the number of points read from the file.

If the Description field is blank then the Name field will be copied to it when the file is read.

The mapping of the data fields is as follows
Internal - MapSource
Latitude - Position

Longitude - Position
Date - Date*
Time - Time*

Altitude - Altitude
Name - Name#+

Description - Description#+
Comment -
Proximity - Proximity#+

Symbol -
Symbol text - "Waypoint"#

Route/Track name - "Point data"#, Route name+, Track name*
Colour -

# for waypoints
+ for routes * for tracks
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Maptech

Maptech Output Options

The Maptech menu option and button, , can be used to define defaults for the short name and symbol to be 
used for the marks created when converting from another format. The output record number will be appended 
to the short name prefix to create the short form name. For example the prefix PG9-W could be used as a 
prefix to identify the walks in the OS Pathfinder Guide number 9. The generated short names would then be 
PG9-W1, PG9-W2 etc.

Maptech Marks Files

Maptech Marks files (*.mxf) can be imported into and exported from Memory-Map Navigator.

Use the menu sequence Overlay | Import... and then select the appropriate file type in the Open dialog box to 
import a Marks file.

Use the menu sequence Overlay | Export Visible... and then select the Maptech Terrain Mark file type to 
export the visible Memory-Map Waypoints.

Memory-Map Navigator can be used to import/export waypoints to various handheld GPS systems, eg Garmin 
eTrex.

The mapping of the data fields is as follows
Internal - Maptech Marks
Latitude - Latitude

Longitude - Longitude
Date - File date 
Time - File time 

Altitude -
Name - Short name

Description - Full name
Comment - Comment
Proximity -

Symbol - Symbol number
Symbol text - Dot, House etc

Route/Track name - "Point data"
Colour - Colour value

The Options menu item Maptech, or the button , can be used to select a default symbol and short name 
prefix.
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Maptech Route Files

Maptech Route files (*.rxf) can be imported into and exported from Memory-Map Navigator.

Use the menu sequence Overlay | Import... and then select the appropriate file type in the Open dialog box to 
import a Route file.

Use the menu sequence Overlay | Export Visible... and then select the Maptech Terrain Route file type to 
export the visible Memory-Map Routes.

The mapping of the data fields is as follows
Internal - Maptech Routes
Latitude - Latitude

Longitude - Longitude
Date - File date 
Time - File time 

Altitude -
Name - Short name

Description - Full name
Comment - Comment
Proximity -

Symbol - Waypoint symbol number
Symbol text - Dot etc

Route/Track name - Route name
Colour - Waypoint colour value

Maptech Track Files

Maptech Track files (*.txf) can be imported into and exported from Memory-Map Navigator. The Track filter 
Option can be used to reduce the number of track points read from the file.

Use the menu sequence Overlay | Import... and then select the appropriate file type in the Open dialog box to 
import a Track file.

Use the menu sequence Overlay | Export Visible... and then select the Maptech Terrain Track file type to 
export the visible Memory-Map Tracks.

The mapping of the data fields is as follows
Internal - Maptech Tracks
Latitude - Latitude

Longitude - Longitude
Date - File date 
Time - File time 

Altitude -
Name -

Description -
Comment -
Proximity -

Symbol -
Symbol text - "Dot"

Route/Track name - Track name
Colour - Track colour value
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Memory-Map CSV Files - Points

Memory-Map CSV files (*.csv) can be imported into and exported from Memory-Map Navigator.

Use the menu sequence Overlay | Import... and then select the CSV file type in the Open dialog box.

Use the menu sequence Overlay | Export Visible... and then select the CSV file type to export data for use with 
POIConverter.

Memory-Map Navigator can be used to import/export waypoints to various handheld GPS systems, eg Garmin 
eTrex.

The first record in the file is used to distinguish Memory-Map CSV files from AutoRoute Pushpin files.

The mapping of the data fields is as follows
Internal - Memory-Map CSV Waypoints
Latitude - Latitude

Longitude - Longitude
Date -
Time -

Altitude -
Name - Unique

Description - Name
Comment - Comment
Proximity - Radius

Symbol - Symbol number
Symbol text - Dot, House etc

Route/Track name - Category*
Colour -

* The output file name will be written to the Category field when creating a CSV file.
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Microsoft

Microsoft AutoRoute PushPins

The POI data are transferred into AutoRoute using the Import Data... item on the File menu or the Import Data 
Wizard button. Select the TextFiles filter (*.txt;*.csv;*.tab;*.asc) and then the particular file that you want to 
import. The Wizard will then take you through the steps required to import the data. It is only necessary to use 
the Next and Finish buttons as all of the required field names are in the text file.

The default Pushpin icon can be changed using the Data Set item on the Format menu. Select a Pushpin and 
use the Show Information item on the Format menu or press the F8 key to display the information.

The first record in the file is used to distinguish Memory-Map CSV files from AutoRoute Pushpin files.
Subsequent records should contain data fields in one of the two following formats:

Longitude, Latitude, "Name", "Information"
OS Grid Reference, "Name", "Information"
Eastings, Northings, "Name", "Information"

The mapping of the data fields is as follows
Internal - AutoRoute PushPins
Latitude - Latitude

Longitude - Longitude
Date -
Time -

Altitude -
Name -

Description - Name
Comment - Information*
Proximity -

Symbol -
Symbol text - "Waypoint"

Route/Track name - "Point data"
Colour -

* Optional

The order of the fields in the input file is determined from the information in the header record. The follow field 
names are accepted

latitude,longitude or os grid reference or eastings,northings
name
information
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Microsoft Maps – Points and Routes

The PushPin and Route data contained within AutoRoute map files (*.axe), Streets and Trips map files (*.est) 
and MapPoint map files (*.ptm) are extracted by running James Sherring's program st2gpx from within 
POIConverter. st2gpx creates a GPS eXchange formatted file (*.gpx) which is then read to extract either the 
PushPin or Route information. The intermediate GPX file, st2gpx.tmp, is deleted afterwards unless the 
program is run in debug mode.

The mapping of the data fields is as follows
Internal - Microsoft Maps
Latitude - Latitude

Longitude - Longitude
Date -
Time -

Altitude -
Name -

Description - Name
Comment - Information
Proximity -

Symbol -
Symbol text - "Waypoint" or <sym>*, "Dot"#

Route/Track name - "Point data", File name#
Colour -

* <sym> element from intermediate GPX file. AR2004
# for Routes
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Microsoft Pocket Streets - Points

To export Pushpin information from Microsoft AutoRoute it is necessary to select an area of the map that 
contains the Pushpin data by 'dragging' an area using the Select tool. Do not click in the area to zoom in on 
the selected region. When the bounding box is visible on the map use the Export Maps for Pocket Streets...
item in the File menu and follow the instructions. This will create two files, a map file (.mps) and a Pushpin file 
(.psp). When the Pushpin file is opened in POIConverter the locations and details (name and the attached 
notes) are extracted.

The coordinates transferred to the psp file are incorrect (by a small but variable amount) when exported from 
versions of AutoRoute newer than AutuoRoute 2001. 

Do not select too large an area of map as it will take a long time to export all of the street detail, and none of 
this is required for the Pushpin transfer. 

The mapping of the data fields is as follows
Internal - Pocket Streets
Latitude - Latitude

Longitude - Longitude
Date -
Time -

Altitude -
Name -

Description - Name
Comment - Notes
Proximity -

Symbol -
Symbol text - "Waypoint"

Route/Track name - "Point data"
Colour -
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Microsoft Excel Files – Points, Routes and Tracks

Waypoints, routes and tracks can be imported from and exported to Microsoft Excel spreadsheets (*.xls). The 
Excel data must be defined on a sheet with column headings exactly as below. Waypoint data must be on a 
sheet named Points, route data on Routes and track data on Tracks. More than one route or track can be 
defined on the same sheet. A new route or track will be assumed to have started when the entry in the "Route 
or Track name" column changes. The column names have been chosen to facilitate the import of data into 
AutoRoute.

The mapping of the data fields is as follows
Internal - Excel column heading

Latitude, Longitude - OS Grid Reference*
Latitude - Latitude*+

Longitude - Longitude*+
Date, Time - Date and Time

Altitude - Altitude
Name - Name 2*

Description - Name*
Comment - Information
Proximity - Proximity

Symbol -
Symbol description - Symbol name
Route/Track name - Route or Track name

Colour - Colour name
* These fields are recognized by the AutoRoute Import Wizard.
+ The coordinates can be specified as an OSGB Reference, in which case these fields should be left blank. 
The values in these fields will be used in preference to the OSGB value if both are defined.

NMEA Log Files - Tracks

Log files that contain NMEA formatted records can be imported into POIConverter. The Track filter Option can 
be used to reduce the number of track points read from the file. The file extensions PGL (TomTom Navigator), 
TXT (Zycast data loggers), LOG (Sony GPS-CS1), GPS (CoPilot Live 7) are supported.

The time, position coordinates, number of satellites used in fixing the position and altitude are extracted from 
$GPGGA and/or $GPRMC records. The satellite numbers from $GPGSA records and the true course and 
speed over ground from $GPVTG records.

The mapping of the data fields is as follows
Internal - NMEA Log Files
Latitude - Latitude

Longitude - Longitude
Date - File date 
Time - Time

Altitude - Altitude
Name -

Description - Speed (mph/kph)*, True course*, Altitude (m)
Comment - Satellite numbers
Proximity -

Symbol -
Symbol description - "Dot"
Route/Track name - File name 

Colour -
* If $GPVTG records are present
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OziExplorer

OziExplorer Output Options

The OziExplorer menu option and button, , can be used to define defaults for altitude, proximity and symbol 
number. The Date and Time fields will be set to those values current when the option dialog box is opened.

OziExplorer Waypoint Files

OziExplorer waypoints defined in the WGS 84 datum can be input and output. The header record is examined 
to check that the data is in OziExplorer format as the WPT extension is also used for Garmin PCX5 waypoints.

The mapping of the data fields is as follows
Internal - OziExplorer Waypoints
Latitude - Latitude

Longitude - Longitude
Date - From TDateTime
Time - From TDateTime

Altitude - Alt
Name - Name

Description - Description
Comment -
Proximity - Proximity

Symbol - Symbol number (0 - 15)
Symbol text - Waypoint, Residence etc

Route/Track name - "Point data"
Colour -

The waypoint names sent to the output file are made unique. The Options menu item OziExplorer, or the 
button , can be used to select default values for the Waypoint Symbol, Altitude and Proximity.
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OziExplorer Route Files

OziExplorer routes defined in the WGS 84 datum can be input and output. The header record is examined to 
check that the data is in OziExplorer format as the RTE extension is also used for Garmin PCX5 routes.

The mapping of the data fields is as follows
Internal - OziExplorer Routes
Latitude - Latitude

Longitude - Longitude
Date - From TDateTime
Time - From TDateTime

Altitude -
Name - Name from W record

Description - Description from W record
Comment -
Proximity -

Symbol - Symbol number (0 - 15)
Symbol text - Waypoint, Residence etc

Route/Track name -Description from R record
Colour -

Although all the waypoint details are stored with each route OziExplorer requires the waypoints to be loaded 
on the map before it will display the route. A waypoint file can be created from a route file within POIConverter. 
First, read the route file, then select the menu option Points or the button and finally, save the data.

OziExplorer Track Files

OziExplorer tracks defined in the WGS 84 datum can be input and output. The header record is examined to 
check that the data is in OziExplorer format.

The mapping of the data fields is as follows
Internal - OziExplorer Tracks
Latitude - Latitude

Longitude - Longitude
Date - From TDateTime
Time - From TDateTime

Altitude - Alt
Name -

Description -
Comment -
Proximity -

Symbol -
Symbol text - "Dot"

Route/Track name - Description
Colour -

On input Date and Time values are extracted from field 5 (TDateTime). The text versions in fields 6 and 7 of 
the input record are not used.
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TomTom

TomTom Output Options

The TomTom menu option and button, , can be used to select the internal field, ie Description, Comment or 
Name, which is to be used when creating names for POI, and the prefix to be used when forming a name for a 
POI that would otherwise be blank. The text used to form the POI names can be truncated in 3 ways; At 32 
characters, At 10 characters but made unique by modifying the last few characters, At first comma in the text 
but with a maximum of 32 characters. The full length of 128 characters may not be visible in map view when 
using TomTom Navigator. Names using more than 32 characters may not be readable in Map mode in 
TomTom Navigator.
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TomTom ASCII Data - Points

An extended form of the TomTom ASCII file (*.asc) format can be read and written by this program. The 
position of a POI can be given either as a pair of values giving its longitude and latitude or as GB Ordnance 
Survey National Grid reference (OSGB36). Optionally, a description field can be given after the name texttext 
but the text will not be used when creating overlay files (*.ov2). NB The longitude value must precede the 
latitude value. 

The extended format is as follows

Longitude, Latitude, "Name", "Description"
OSGB reference, "Name", "Description"

any line starting with a semi-colon will be treated as a comment and it will be ignored when the file is read.

The mapping of the data fields is as follows
Internal - TomTom ASCII
Latitude - Latitude

Longitude - Longitude
Date -
Time -

Altitude -
Name -

Description - Name
Comment - Description*
Proximity -

Symbol -
Symbol text - "Waypoint"

Route/Track name - "Point data"
Colour -

* Optional

The Options menu item TomTom, or the button , can be used to create a default style for the POI names 
when they are output.



POIConverter version 4.08

Page 35 of 40

TomTom Overlays - Points

Any TomTom overlay files, from Navigator and Route Planner, that are to be converted to another format must 
be transferred from the Pocket PC to the Windows PC running this program. Direct access of the Pocket PC 
files is not supported. 

When saving as a Route Planner overlay it is necessary to specify the file extension (.ovr) as the default file 
extension is .ov2

The mapping of data fields is as follows
Internal - TomTom overlay
Latitude - Latitude

Longitude - Longitude
Date - File date 
Time - File time 

Altitude -
Name -

Description - Name
Comment -
Proximity -

Symbol -
Symbol text - "Waypoint"

Route/Track name - "Point data"
Colour -

Note: Route Planner overlays store the position coordinates in 10,000ths of a degree. Therefore, any
coordinates read from an ovr file will show only 4 significant figures after the decimal point when output to text 
files.

The Options menu item TomTom, or the button , can be used to create a default style for the POI names 
when they are output.
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TomTom Navigator Itinerary Files - Routes

Itinerary files can be opened and saved using tap-and-hold in the Itinerary screen on the PocketPC. When 
creating a route using MapSource make sure that Edit | Preferences... | Routing is set to Use Direct Routes
otherwise all of the intermediate turns will be output. TomTom Navigator does not require these intermediate 
details.

The locations of route points transferred from another mapping program may not be on a road in the TomTom 
map. The order and type of an itinerary entry can be changed on the TomTom unit.

The mapping of the data fields is as follows
Internal - TTN3 Itinerary
Latitude - Latitude

Longitude - Longitude
Date - File date 
Time - File time 

Altitude -
Name - Entry type*

Description - Name
Comment -
Proximity -

Symbol -
Symbol description - "Dot"
Route/Track name - File name 

Colour -
* On input set to Waypoint (0 and 1), Destination (2), Visited (3) and Start (4), otherwise set to Undefined.

TomTom Navigator Log Files - Tracks

Log files (*.pgl) can be recorded by TomTom Navigator to show the track followed when navigating. Log files 
that contain NMEA formatted records can be imported into POIConverter. The Track filter Option can be used 
to reduce the number of track points read from the file.

The time, position coordinates, number of satellites used in fixing the position and altitude are extracted from 
$GPGGA records. The satellite numbers from $GPGSA records and the true course and speed over ground 
from $GPVTG records.

The mapping of the data fields is as follows
Internal TomTom Logs
Latitude Latitude

Longitude Longitude
Date File date 
Time Time

Altitude Altitude
Name

Description Speed (mph/kph)*, True course*, 
Altitude (m)

Comment Satellite numbers
Proximity

Symbol
Symbol description "Dot"
Route/Track name File name 

Colour
* If $GPVTG records are present
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Internal Data Structure

The program uses a structure, with the following fields, to store the data read from the differently formatted 
input files. The Fortran 90 types and sizes of the fields are given in the table below

Field - Field Type and Size (bytes)
Latitude - REAL*4

Longitude - REAL*4
cLatitude - CHARACTER(LEN=16)

cLongitude - CHARACTER(LEN=16)
Date - CHARACTER(LEN=10)
Time - CHARACTER(LEN=8)

Altitude (m) - REAL*4
Name - CHARACTER(LEN=128)

Description - CHARACTER(LEN=256)
Comment - CHARACTER(LEN=256)

Proximity (m) - REAL*4
Symbol - INTEGER*4

Symbol text - CHARACTER(LEN=20)
Route/Track name - CHARACTER(LEN=64)

Colour - CHARACTER(LEN=6)
CountryCode - CHARACTER(LEN=3)

Type - CHARACTER(LEN=5)
PostalCode - CHARACTER(LEN=16)

City - CHARACTER(LEN=128)
Street - CHARACTER(LEN=128)

HouseNumber - CHARACTER(LEN=8)
Telephone - CHARACTER(LEN=32)

NationalImportance - CHARACTER(LEN=1)
SourceID - CHARACTER(LEN=8)

ExtentionContentType - CHARACTER(LEN=1)
ExtentionContent - CHARACTER(LEN=64)

XEBAdata(10) - CHARACTER(LEN=128)

The current limits are: 
Number of records = 60,000
Number of Extended EBA fields = 10
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History

4.08 12/4/2008 EBA configuration file added. Points output in KML format will be placed in folders: grouped 
using the Type field contents for EBA files and POI symbol name for non-EBA files.

4.07 6/4/2008 Warn if not a Garmin Type 2 GDB file. TomTom ITN file output changed to match Navcore 7 
codes. Command line mode supported.

4.06 21/3/2008 EBA City and Street field sizes increased to 128. Error when writing a single point to KML file 
fixed.

4.05 9/3/2008 Storage limit checks added for EBA subroutines.

4.04 4/3/2008 Extended EBA format supported. Field types and sizes defined in the Help file.

4.03 29/02/2008 EBA address fields filled when KML files are read.

4.02 27/02/2008 Internal file structure extended to provide support for Elektrobit EBA CSV files. NMEA log 
files using only a carriage return character (Hex 0D) record terminator can now be read. Altitude value written 
to Google Earth Points files.

3.21 17/10/2007 Google Earth KML Points, Routes and Tracks output added. File filters for Open and Save 
written to Windows Registry.

3.20 29/08/2007 Code improvements to Maptech RXF file input.

3.19 18/06/2007 Option to filter NMEA data using PDOP value added. Default is to accept all entries.

3.18 23/10/2006
Proximity field added to GPX Options dialog box. Google Points data can be read from KPL formatted files.

3.17 26/8/2006
POI (waypoints) can be written to and read from Garmin GPS database files (*.gdb). The GPX tag <type> is 
used to define a Memory-Map Marks category. The output file name is used as the category name. The code 
used to output GPX files containing multiple tracks has been corrected.

3.16 29/6/2006
The new Type 100 records in TomTom overlay files are ignored when the file is read.

3.15 5/2/2006
Header records of GPS eXchange output files modified for compatibility with Garmin MapSource. The disk 
drive letter is extracted from program path for use with qtXLS licence file. Eastings and Northings can be used 
in an AutoRoute CSV input file.

3.14 12/08/2005
GPS eXchange Options menu item and button added for waypoint name style. Microsoft Streets and Trips 
map file (*.est) support added. Longitude error corrected for locations in the USA read from a Pocket Streets 
file (*.psp).

3.13 12/07/2005
Waypoint output in Mapopolis Maplet format added. The error that prevented the default bitmap file, stored in 
the program folder, from being used for newly created TomTom overlays was corrected.

3.12 30/05/2005
Waypoint output in Destinator 3 CSV format added.
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3.11 22/04/2005
Storage size increase to 40,000 points and MapPoint name added to file filter.

3.10 21/1/2005
Waypoints, Routes and Tracks in OziExplorer format (WGS 84 datum) can be input and output. The TomTom 
utility MakeOV2 is run to create TomTom overlay files as the previous internal code does not create Type 1 
(Skipper) records. TomTom options added for POI name mapping, length and blank name prefix. GPX input 
routine modified to cope with large amounts of embedded text that should be ignored by POIConverter.

3.09 17/9/2004
Symbol mapping added for Memory-Map CSV data. Various bug fixes.

3.08 31/8/2004
Unique name algorithm changed to use only alpha characters.

3.07 20/8/2004
Waypoints stored in Memory-Map CSV files can be input and output. The path of the last used input folder is 
saved in the Windows Registry and it is used as the default folder when the program is restarted.

3.06 8/7/2004
The waypoint identifiers output to the Garmin WPT and RTE files are made unique. Storage limit check added 
in all read routines. The Garmin Option to replace the waypoint IDNT field on output now works correctly.  
Both NMEA $GPRMC and $GPVTG records used to extract course and speed data from TomTom Navigator 
Log files (*.pgl).

3.05 12/6/2004
The worksheet name and column names are checked prior to importing data from an Excel file.

3.04 6/6/2004
Limit on the number of POI increased to 15000 and missing limit checks added in AutoRoute and GPX 
subroutines.

3.03 29/5/2004
qtXLS library updated to 24/5/04 version. Error caused by blank Date/Time field in MapSource txt file track 
data has been corrected.

3.02 7/5/2004
When converting AutoRoute Map files the ST2GPX output is sent to the file st2gpx.tmp and is left in the input 
file folder after the run. ST2GPX will not produce an output file if the path to the program contains spaces. As 
a work-around, POIConverter now installs to the folder C:\Richard_Davies\POIConverter.

3.01 1/5/2004
Support for Excel spreadsheets reinstated but there are still some problems. Support added for TomTom 
Navigator 3 Itinerary files (*.itn) and NMEA Log files (*.pgl).

3.00 27/4/2004
Support for Excel spreadsheets disabled pending qtXLS library update. Identifier field deleted from internal 
structure. Garmin PCX5 coordinate output changed to decimal degrees. Decimal degree input support added.

2.02.1 20/4/2004
Support for Pocket Streets PushPin file (*.psp) input reinstated. ST2GPX updated to version 0.5.

2.01 30/3/04
Support for Pocket Streets PushPin file (*.psp) input removed. Comma separated value (*.csv) file input 
added.
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2.00 21/3/04
Input and output of route and track data added for Maptech, Garmin PCX5 and GPX formatted data. Input of 
route and track data from MapSource text file added.

1.03 10/03/04
Pushpin names extracted from AutoRoute Map files, via the intermediate GPX files, passed to TomTom 
Navigator overlay Name field.

1.02 14/01/04
Pushpin data extracted from Microsoft AutoRoute Map files using James Sherring's st2gpx program. Reading 
and writing of GPX files supported. Garmin conversion uses the H IDNT record to determine field lengths on 
input.

1.01 07/07/03
Error in the transfer of Pocket Streets notes corrected.
TomTom Route Planner overlay (ovr) file support added.

1.00 23/06/03
Initial release.
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